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OVERVIEW

In this activity, students review their prior knowledge about various types

of plate boundaries. Next students use the IRIS Earthquake Browser (IEB;
Appendix A) to investigate well-known examples of some of these boundaries.
Students are asked to pay particular attention to the spatial distribution, rate
of seismicity, and depth of quakes in each area. Students then point IEB to a
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Figure 1: Screen grab of IEB’s “mystery”
location of all earthquakes since 1/1/2011.

OBJECTIVES

new region and are asked to
use the “templates” of seismic
evidence they have previously
constructed for the primary
plate boundaries to argue for
what is occurring within the
mystery region.

This activity is designed to
engage students in evidence
that supports plate tectonics
while also raising questions
about earthquakes and plate
tectonics. Questions and claims
developed during this lesson
should be recorded and used
to drive follow-up instruction
during the EXPLAIN phase of the
activity.

Students will be able to use the IRIS Earthquake Browser to

- Explore current seismicity of our planet

- Examine earthquake patterns at tectonic plate boundaries

- ldentify geomorphologic features associated with these plate boundaries

« Describe the global distribution of earthquakes

- Use seismic evidence to identify the plate boundary model that “best”

supports the data for each site.

1
EXPLORING PATTERNS OF GLOBAL SEISMICITY

A

b - -
N
[ ]
Intermediate
70-80 min
Individual or pairs
Web-Based
TABLE OF CONTENTS
Overview.............c..oo... 1
Materials................... 2
TeacherPrep ............... 2
Lesson development ....... 3
Appendices ................ 4
Student Worksheet..... SW-1
Instructor Answer Key ..... 17


http://www.iris.edu/hq/inclass/lesson/455

MATERIALS

« Computers or tablets with internet access for each
student or pair of students

Make changes, press Apply:

Max quakes: 2000 =

Priority: | Newest G
« IRIS Earthquake Browser (IEB): www.iris.edu/ieb

« Student Worksheets Pages SW-1 - SW-6

PREREQUISITES

« Complete the short-term activity, “Where’s Waldo”
and/or the longer activity, “What's Shaking?”
from the lesson, “Plotting Earthquake Epicenters”:
www.iris.edu/hg/inclass/lesson/467

Time Range:

Magnitude Range:

Depth Range (km):

Apply |

Earthquake Count:
2000 of 11046 (2000 visible)

TEACH ER PREP Figure 2: Screen grab of IEB’s “Site 1” that includes epicenters for

+ Read "Using IRIS Earthquake Browser" in Appendix A all earthquakes since 1/1/2011
to practice using IEB.

« For Plate Tectonics background, see Appendix B
and the animations and videos in the gray box
below.

« The egg analogy of Earth’s layers is addressed in the
Student Worksheets. See Appendix C.

« Print Student Worksheets, Pages SW-1 — SW-5.

Figure 3: Screen grab of Figure 2 map in 3-D view above,
with "View" > "Look" > "North" selected.

ANIMATIONS & VIDEOS ABOUT PLATE BOUNDARIES

3 boundary types - Animation:

« www.iris.edu/hqg/inclass/animation/492
3 boundary types - Video Lecture:

« www.iris.edu/hg/inclass/video/106

Plate tectonics/convection—What are the forces that drive plate tectonics-

- www.iris.edu/hg/inclass/animation/557

Divergent Boundaries
« www.iris.edu/hg/inclass/animation/90

« www.iris.edu/hg/inclass/animation/132

Convergent Boundaries
» www.iris.edu/hg/inclass/animation/89

« www.iris.edu/hg/inclass/animation/468

Transform Boundaries
. www.iris.edu/hg/inclass/animation/58

- www.iris.edu/hg/inclass/animation/53
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http://ds.iris.edu/ieb/index.html?format=text&nodata=404&starttime=1970-01-01&endtime=2025-01-01&minmag=0&maxmag=10&mindepth=0&maxdepth=900&orderby=time-desc&limit=1000&maxlat=85.75&minlat=-85.75&maxlon=180.00&minlon=-180.00&zm=1&mt=ter
http://www.iris.edu/hq/inclass/lesson/467
https://www.iris.edu/hq/inclass/animation/492
https://www.iris.edu/hq/inclass/video/106
https://www.iris.edu/hq/inclass/animation/557 
https://www.iris.edu/hq/inclass/animation/90
https://www.iris.edu/hq/inclass/animation/90 
https://www.iris.edu/hq/inclass/animation/132
https://www.iris.edu/hq/inclass/animation/89
https://www.iris.edu/hq/inclass/animation/468
ansform http://www.iris.edu/hq/inclass/animation/fault_transform
https://www.iris.edu/hq/inclass/animation/58
https://www.iris.edu/hq/inclass/animation/53

LESSON DEVELOPMENT Table 1: Lesson flow and timing

This activity is structured using the “OPERA” system (Appendl).< D). OPERA Time (min)
Tasks A and B of Part 4 of the Student Workshop uses an Inquiry
gpproach to help students use Evidence and Reasoning (Appendix E) to Open 10
explain the phenomena thfey have researched us.mg the IRIS Earthquake Prior knowledge 5
Browser. There are two options, A and B, depending on student level
and/or time to complete the task. Explore/Explain 40
Open Reflect 20
Open Fhe IRIS Earthquake ﬁrowser with your students ar.1d give them Apply Homework or 15
a brief overview of how it works ( Appendix A). They will use this web |
application to examine earthquake event data on a map. 70 -85
Prior Knowledge - 5 Minutes
If needed, review knowledge about the tectonic plates, such as: TIMING TIP

1. Which crust is older, oceanic or continental?
2. Which type of oceanic crust is more likely to be subducted, old or
new? Why?
3. Predict the results of the following plate collisions and the surface
morphology you would see as a result:
+ Ocean-Ocean
+ Ocean-Continent
« Continent-Continent
After you have briefly reviewed knowledge about plate boundaries, ask
the students to consider:
?? “How often do earthquakes occur?”

?? “Where do earthquakes occur?”
In both cases accept all answers and make a list to be revisited
during the "Reflect" phase of this lesson. The goal is to uncover any
alternative thoughts that the students may have.

We will return to these two questions in the Reflect phase.

Explore/Explain — 40 Minutes

To get the students used to the controls of IEB, have them set the "Max quakes" to
10,000 to think about:

Where are the greatest concentrations of earthquakes?

Where do the deepest earthquakes (=300 km) occur?
Click "Show plates" on.

Now set "Magnitude Range" by clicking off "All Values" and typing in "8 < mag < 10"
Where do the big (=8.0 magnitude) earthquakes occur?

Switch to a satellite view of the world. Do earthquake patterns correlate with any
visible features? If so, describe the correlations.

Now assign students to work either independently or in small groups to complete
Parts 1 through 4 oaf the Student Worksheets. Here they have an extended
opportunity to explore and organize earthquake event data. The Tasks in Part 4 are
optional, but offer an opportunity to use Evidence & Reasoning.

Discovery questions for each site are on the next page in gray box..
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If needed, the activity can be
shortened by omitting any of
the following:

» One or more questions
from Part 2 of the Student
Worksheet

« Site 4 from the data table.
« Task A and B from Part 4



DISCOVERY QUESTIONS FOR THE
4 SITES IN THE STUDENT WORKSHEET

Site 1: CONVERGENT BOUNDARY (Ocean-continent collision; Japan)
How frequent are earthquakes in this region?

What is the depth distribution of the earthquakes? Is there a pattern in the
earthquake depths? If so, how do you explain it?

Do the earthquakes correspond to any visible features in satellite view? If
so, what are these features?

Find another region of the world that has similar features to the ones you
noted near Japan. What is the region and are the earthquake patterns
there similar?

Site 2: DIVERGENT BOUNDARIES (Mid-ocean ridge; Mid-Atlantic Ridge)

How frequent are earthquakes in this region? How does this compare to the
seismicity near Japan?

What is the typical depth of earthquakes in this region? How does this
compare to earthquakes near Japan?

How do you explain the differences in depth and frequency of earthquakes
between the mid-ocean ridge and Japan?

Do the earthquakes correspond to any visible features in satellite view? If
so, what are these features?

Find another region of the world that has similar features to the ones you
noted in the central Atlantic. What is the region and are the earthquake
patterns there similar?

Site 3: CONVERGENT BOUNDARY (Continent-continent collision;
Himalayas)

Do the earthquakes correspond to any visible features in satellite view? If
so, what are these features?

How does this region compare to Japan?

Why do you think that the earthquake belt is so broad across the
highlands?

Site 4: DIVERGENT BOUNDARY (Continental rift zone; East African Rift)
Which countries are the most seismically active?
Do earthquakes in East Africa tend to be deep or shallow?

Of the types of boundaries investigated earlier, which one best explains the
pattern you see in East Africa?

In satellite view, do you see any features consistent with the type of
boundary you proposed in the previous question? If so, identify them. If
not, why do you think that is?

Based on the type of plate boundary you have discovered in this region,
what do you think will happen in this region of the world over time?
What large-scale features do you expect to see developing in the future?
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Reflect - 15 Minutes

As a whole class, reflect again on the students’ responses to the two

questions raised in the "Prior Knowledge" section above.

?? How often? [Answered in Appendix F]
?? Where?

ANSWER: Earthquakes occur on or near plate boundaries principally in
3 large zones of the Earth: the Pacific Ring of Fire, The Alpide Belt (from
Sumatra and Himalayas, to the Atlantic), and the Mid-Atlantic Ridge.

?? How are the various sites similar and different from one another?

ANSWERS:

Similar: Earthquakes cluster near plate boundaries. Similar physical
features are associated with the different models. The 2 convergent
sites show deepening earthquakes beneath the overlying slab
(subduction = Japan; continental collision = Himalayas). The Mid-
Atlantic Ridge, and the East African triple junction at the Red Sea
(Figure 4) both have active spreading ridges that separate two plates

thus have shallow earthquakes.

Different: Depth, size, and distrubution of the earthquakes.

Topography.

?? Which of the tectonic models (Page SW-4) was best supported by the

evidence from Site 4?

ANSWER: Site 4 is a tricky region with a triple junction that connects
two spreading regions: the Red Sea is a spreading center between
two plates. The E. African Rift Zone is a diffuse area of incipient rifting
that may become a spreading ridge in millions of years. Thus, the best

model is Model 3—Divergent boundary.

?? How about the other Sites? Note: Plate boundary models can further

support the discussion.

Apply - Homework (or 15 minutes in class): Part 5 of the Student

Worksheet.
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worksheets. This complicated zone
can be considered optional for shorter
class time.



APPENDIX A
Using the IRIS Earthquake Browser (IEB)

The IRIS Earthquake Browser (IEB; http://www.iris.edu/ieb/) is an interactive map service for viewing
Earthquake Epicenters superimposed on a map of the world. This web-service accesses several earthquake
catalogs stored in the IRIS database. In total, the database contains around 2 million unique events dating
from the early 1960s until present. By filtering the data, the user can interrogate the catalogues by controlling
a number of different parameters (magnitude, depth, timeframe etc), and determining how many matching
events are shown. Because of practical limitations, only a small subset of all earthquakes may be shown in
any given map view. However, by zooming and panning, the user can quickly discover all of the earthquakes
held in the IRIS database for any region of the globe.

Map Overview e SPY IRIS Earthgquake Browser l Gpeinas
This diagram describes some of o .l o oy B e
the features available in the IEB, } LA ety nease
with numbered descriptions o2 R T
below : d . Sl
: ol et Ll Deh Rarge [km:
For a full overview of this site and “h e T Apply
all its many features, please visit: % P |
www.iris.edu/ieb/help/ Ly o i Ot Bw b 9
i :-\I.: : ey plates: | Q-
x 3 ol i " i Dol | wecreanon o '—'1 n
: : ® 1ken) | Open s Ttk 30 Vimeut
o -4 H h =11
?.I g 120 T H 2
&
@ !::.:dl;llr':.:ll.l':
a4z

1. Earthquake Count - Displays how may earthquakes are displayed, how many could have been displayed
(and how many are visible on the map at this time).

2. Open as Table - Use to links to export data from the map, currently to a table, where you can copy and paste
into other programs like Excel.

3. Map Views - Select from various Google map view modes such as satellite or terrain.

4. Depth Scale - Circle colors indicate the depths of earthquakes (kilometers)

5. Earthquake Filter - A set of options that allow one to determine which subset of available earthquakes are
displayed.

6. Magnitude Scale - Circle sizes indicate earthquake magnitudes

7. Region Selection - Use this to select a map region and zoom down to it. Only events in the selected region will
be displayed.

oo

. Navigation Information - Displays the lat/lon bounds of the current selection and the lat-lon coordinates of the
cursor.

9. Show Plates - Shows or hides the display of (clickable) tectonic plate boundaries.
10 Go To Region - Takes map to one of several predefined regions of interest.
11. NEW! 3D Viewer - Opens a new window with a rotatable, zoomable 3D view of the data. See next page for tip.
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TIP FOR USING THE 3-D VIEWER

Because it is difficult to control the motion of the
3-D view, have students practice selecting just two
options shown at images B and C:

A. Click "3D View"to find "View" pull-down menu
B. "View"> "Look" > "North" and

C. "View" > "Rotate" > "Side to Side".

Students can compare the 3D views
more easily by controlling the motion.

@ View Help
\

View Help
B Reload Re-orient the viewpoint
Move >
Rotate >
Scale >
Hide axes
Shading off (West
Hide coast
Hide plates

View Help
Reload Auto rotate in d
Look >
Move >
Top-to-Bottom
Scale > Side-to-Side
Hide axes \ Clock-wise

Shading off\Stop All Rotation
Hide coast

Hide plates
Snapshot
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APPENDIX B

Teacher Background CRUSTAL
Plate Tectonics COMPOSITION
Plate tectonics theory describes how Earth's rigid lithosphere, composed The density of the crust
of Earth’s crust plus the uppermost mantle, is broken into many large determines its behavior.
pieces called lithospheric, or tectonic plates. The lithospheric plate There are 2 types of crust:
"floats" on the more-dense, flowing asthenosphere. These plates move Oceanic crust is chiefly
so slowly that the motion can only be detected by sensitive GPS (Global basalt, which is
Positioning Systems). Plate motion is driven by density differences relatively dense

in the asthenosphere. As the plates move about they are constantly (~2.9 g/cm3).
interacting with one another in a variety of ways. Depending on the type Continental crust is

of interaction and the density of the crust, these interactions can result in primarily granite,
the formation of large-scale features, such as mountains and deep ocean which is less dense
trenches. They also cause more abrupt and catastrophic effects, such as than basalt
earthquakes, tsunamis, and volcanism. (~2.7 g/cm?3).

Both types are less dense
than the highly viscous

Plate Boundaries asthenosphere (3.1 to

There are three general types of plate boundaries: divergent 3.3 g/cm3) below them.
(constructive; crust is created), convergent (destructive; crust is During convergence,
destroyed), and transform (crust is neither created nor destroyed). however, the denser
Each general type has multiple ‘species’: Divergent boundaries can be rock (like oceanic basalt)
spreading ocean ridges or continental rift zones. Convergent boundaries sinks lower into the

can occur between two oceanic plates, an oceanic and continental plate, asthenosphere than

or between two continental plates. Transform boundaries are found less-dense rock (like

on the sea floor, where they connect segments of diverging mid-ocean continental granites).

ridges. California's San Andreas fault is also a transform boundary.

It is important to note that the static size of the Earth implies that crust
must be destroyed (at convergent boundaries) at about the same rate it is
being created (at divergent boundaries).

Divergent Boundaries - New ocean crust is created at
divergent boundaries, where plates are moving apart.
In these regions, mantle material (magma) penetrates Divergent boundary
the thinning crust and solidifies. As the oceanic plates
pull apart, dense oceanic crust is formed creating a
mid-ocean ridge. Divergent boundaries can form either
in oceanic or continental lithosphere. If a divergent
boundary develops within continental crust, the region
breaks into a system of mountains and valleys, known as
basins and ranges. The low-lying area may eventually fill
with water and form a new ocean basin. Newer, hotter
oceanic crust is more buoyant (less dense) than older,
colder oceanic crust, thus the ocean floor adjacent to
spreading ridges is bathymetrically higher than away
from the ridge (watch the following animation to learn
more about basins and ranges:.
www.iris.edu/hg/inclass/animation/132.)

Earthquakes occur only in brittle rock, thus there are no
earthquakes in the asthenosphere.
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 http://www.iris.edu/hq/inclass/animation/basin__range_structural_evolution
http://www.iris.edu/hq/inclass/animation/132

Convergent Boundaries - As plates move, some collide with

one another at convergent boundaries. At an ocean-ocean,
or ocean-continent convergent boundary, denser crust will
be subducted beneath less-dense crust. At a continent-
continent boundary, neither will subduct and crust is thrust
upward.

Ocean-ocean plate boundaries can form very deep ocean
trenches Ex. Marianas Trench).

At ocean-continent boundaries, subducting crust plunges
into the mantle, the sinking plate releases water as it
warms up in the mantle (think of the plate as sweating).
The water triggers small amounts of melting in the hotter
rocks of the overlying mantle rock. This results in rising
magma that slowly penetrates the crust above the zone of
melting, resulting in volcanoes. Over time, oceanic crust

is destroyed in subduction zones. (Ex. Cascadia, Andes,
Aleutian Islands, Indonesia.)

When continent-continent boundaries collide, neither
can be subducted since the density of continental crust

is too low to allow subduction into the denser mantle.

As a result, the collision will result in mountain formation
(Ex. Himalayas, Alps).

Transform Boundaries - Plates do not always collide or pull

apart. Sometimes they grind horizontally against each
other with strike-slip motion, resulting in the formation of
a transform fault. Although the main motion is horizontal,
transform boundaries may have slight convergent or
divergent motion adding a slight vertical component.
Transform boundaries are not a single strike-slip fault,
but consist of a zone of parallel and subparallel strike-slip
faults.

While this activity doesn't specifically include Transform
boundaries, students could examine the seismicity of the
San Andreas, CA region and compare it to what they have
learned about the other types of plate boundaries.
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Continental crust

-
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The deepest earthquakes occur in subduction
zones where the diving plate is still cold and
brittle as it reaches over 500 km deep.

Transform boundary

Earthquakes in strike-slip zones tend to be
shallow.



APPENDIX C

Earth vs. Egg—Comparing layer thickness . Earth
VS.

Video demonstration of the simple math: Egg -
www.iris.edu/hg/inclass/video/101 \ _ ;

The exercise of comparing the Earth to an eggis a
useful visualization that helps students understand Earth radius = 6370 km

the thickness of plates on a global scale. We live on the L'th"lSPhere*p'a‘EJ thickness = 100 km
What % of Earth radius is lithosphere?

surface of a really big sphere, thus it is difficult to grasp

the sense of scale. Egg radius = 0.75 inch
Egg shell thickness = 0.015 inch

This classroom lecture presents a simple conceptual What % of egg radius is shell?
model of the relative thicknesses of the Lithosphere by
measuring a simple hard-boiled egg. The hard-boiled

egg is used as a scale model for the zones of the Earth.
The shell is to the egg as the lithosphere is to the Earth;

How do these compare?

Key Comparisons from Video Demo (screen grab)

the yolk is to the egg as the core is to the Earth. This + Measure the diameter of the egg, then measure the
demonstration highlights the idea that the lithosphere thickness of the egg shell
is a thin shell. « Ratio of egg shell to egg radius is about 2%

« Ration of lithosphere to Earth's radius is about 2%

Initial questions and analagous scale
?? What is the outer layer of the earth and egg each called?
Earth’s lithosphere (tectonic plate) solid outer layer, and the egg’s shell.
?? What is the middle layer of the earth and egg each called?
Earth’s mantle and the egg white
?? What is the center layer of the earth and egg each called?
Earth’s core and the egg yolk

Thickness & Composition of Earth’s Layers
Lithosphere
« Thickness - 50-100 km thick (The crust is about 6 km or 4mi thick)
« Composition - Rock - Includes the continents and the ocean floor
Mantle
« Thickness: 2,900 km or1,802 mi thick

« Composition - silicon, oxygen, aluminum, iron, and magnesium -
solid rock

Core

« Thickness ~ 3477 km (Inner core = 1192 km or 745 mi. Outer core
= 2285 km or 1,428 mi

« Composition: Nickle and iron
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APPENDIX D
OPERA Learning Cycle

A learning cycle is a model of instruction based on scientific inquiry or learning from
experience. Learning cycles have been shown to be effective at enhancing learning because
by providing students with opportunities to develop their own understanding of a scientific
concept, explore and deepen that understanding, and then apply the concept to new
situations. A number of different learning cycles have been developed. However, all are closely
related to one another conceptually, and differ primarily in how many steps the cycle is broken
into. The “flavor” of learning cycle that you choose is primarily up to what works best for you,
just pick one or two and use it as the basic formula for all your instruction.

This lesson is designed around a learning cycle that can be remembered as O-P-E-R-A.
OPERA is convenient when designing lesson-level instruction because one can generally
incorporate all the major components into the single experience. Each phase of the OPERA
cycle is briefly outlined below.

Instructional Stage

Open the lesson with something that captures students’ attention. This is an
Open invitation for learning and leaves students wanting to know more.

Assess students’ Prior Knowledge and employ strategies that make this prior

Prior - )
knowledge knowledge explicit to both the instructor and the learner
Plan and implement a minds-on experience for students to Explore the content
Explore

Reflect on the concepts the students have been exploring. Students verbalize
their conceptual understanding or demonstrate new skills and behaviors.
Reflect Teachers introduce formal terms, definitions, and explanations for concepts,
processes, skills, or behaviors.

Practice concepts, skills and behaviors by Applying the knowledge gained in a
Apply novel situation to extend students’ conceptual understanding.
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APPENDIX E

Inquiry and Scientific Explanations: Helping Students Use Evidence and Reasoning

(download full article from:
www.katherinelmcneill.com/uploads/1/6/8/7/1687518/mcneillkrajcik_nsta_inquiry_2008.pdf

"Science is fundamentally about explaining phenomena by determining how or why they occur and the
conditions and consequences of the observed phenomena. For example, ecologists may try to explain
why species diversity is decreasing in an ecosystem, or astronomers may try to explain the phases of the
Moon based on the relative positions of the Sun, Earth, and Moon. When scientists explain phenomena
and construct new claims, they provide evidence and reasons to justify them or to convince other
scientists of the validity of the claims.

"To be scientifically literate citizens, students need to engage in similar inquiry. They need to understand
and evaluate explanations that appear in newspapers, in magazines, and on the news to determine their
credibility and validity. For example, a newspaper article may claim that stem cell research is important
for human health and for treating diseases. Students need to be able to critically read that article by
evaluating the evidence and reasoning presented in it. That capability allows students to make informed

decisions. 122 Science as Inquiry in the Secondary Setting Students should also support their own
written claims with appropriate justification. Science education should help prepare students for this
complex inquiry practice where students seek and provide evidence and reasons for ideas or claims"

TABLE: Base Explanation Rubric is Appendix B from the above article

Component

Level

0

1

2

Claim—A conclu-
sion that answers the
original question.

Does not make a
claim, or makes an
inaccurate claim.

Makes an accurate
but incomplete
claim.

Makes an accurate
and complete claim.

Evidence—Scientific
data that supports
the claim. The data
needs to be appropri-
ate and sufficient to
support the claim.

Does not provide
evidence, or only
provides inap-
propriate evidence
(evidence that does

not support claim).

Provides appropri-
ate but insufhicient
evidence to support
claim. May include
some inappropriate
evidence.

Provides appropri-
ate and sufhicient
evidence to support
claim.

Reasoning—A justifi-
cation that links the
claim and evidence.
It shows why the data
count as evidence

Does not provide
reasoning, or only
provides reasoning
that does not link
evidence to claim.

Provides reasoning
that links the claim
and evidence. Re-
peats the evidence
and/or includes

Provides reasoning
that links evidence
to claim. Includes
appropriate and
sufficient scientific

by using appropriate some—but not principles.
and sufficient scien- sufficient—scientific
tific principles. principles.
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APPENDIX F—HOW OFTEN DO EARTHQUAKES OCCUR?

[The complete fact sheet below is available from: www.iris.edu/hg/inclass/fact-sheet/153]

Earthquakes are always happening somewhere

Earth is an active place and earthquakes are always happening somewhere. In fact, the National
Earthquake Information Center locates about 72,000-14,000 earthquakes each year!

This fact sheet illustrates information on the frequency of earthquakes of various magnitudes,
along with details on the effects of earthquakes and the equivalent energy release. On average,
Magnitude 2 and smaller earthquakes occur several hundred times a day world wide. Major
earthquakes, greater than magnitude 7, happen more than once per month. “Great earthquakes’,
magnitude 8 and higher, occur about once a year.

Magnitude Energy Release
) (equivalent kilograms of TNT)
Effects Earthquakes Energy Equivalents
T Chile (1960) —- 15,000,000,000,000
Alaska (1964)

9 —— largest recorded eathquakes Sumatra (2004)

—— 476,000,000,000

destruction over vast area Japan (2011) .
massive loss of life Chile (2010) Krakatoa Eruption
8 — great earthquake San Francisco, CA (1906 1 @ World’s Largest Nuclear Test (USSR) —— 15,000,000,000
severe economic impact New Madrid, MO (1812) Mount St. Helens Eruption
farge loss of life Charleston, SC (1886)
7 -4 cr;va/'or eaghg;;gke) Haiti (2010)-%-18 —— 476,000,000
amage 1ons, .
it Northridge (1994) o .
Hiroshima Atomic Bomb
6 —— strong earthquake 120 —— 15,000,000
property damage
Long Island, NY (1884)
5 —» moderate earthquake 1.500 —— 476,000
some property damage ’ Average Tornado
4 —— light earthquake 10,000 —— 15,000

noticeable shaking

Large Lightning Bolt

3+ g};’;‘,’f fzft”hq”ake 100,000 Oklahoma City Bombing —1— 476
Moderate Lightning Bolt
2 —— generally not felt 1 ,000,000 —+15
Number of Earthquakes per year (worldwide)

The left side of the figure above describes the effects of an earthquake by magnitude. The larger
the number, the bigger the earthquake. Significant earthquakes are noted on the left side of the
shaded tower. The shaded area indicates how many earthquakes of each magnitude occur every year.
The events on the right side of the tower show equivalent energy release.

The 2004 earthquake in Haiti, for example, was magnitude 7.0. Earthquakes this size occur about
20 times each year worldwide. Although the Haiti earthquake is considered moderate in size, it caused
unprecedented devastation due to poor building material and construction techniques resulting in
estimates of $11 billion to reconstruct. The earthquake released the energy equivalent to 476 million
kilograms of explosive, about 100 times the amount of energy that was released by the atomic bomb
that destroyed the city of Hiroshima during World War I1.

The largest recorded earthquake was the Great Chilean Earthquake of May 22, 1960 which had a
magnitude of 9.5. The great earthquake in 2004 in Sumatra, Indonesia measuring magnitude 9.1
produced tsunamis that caused widespread disaster in 14 countries. A magnitude 9.0 earthquake in
Japan in 2011 also caused large tsunamis. All three were mega-thrust earthquakes on subduction-zone
boundaries that, in a period of minutes, released centuries of accumulated strain and caused rebound in
the overlying plates. Because great earthquakes release so much energy, the five largest earthquakes
are responsible for half of the total energy released by all earthquakes in the last century.
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APPENDIX G—NGSS SCIENCE STANDARDS & 3 DIMENSIONAL LEARNING

Earth’s Systems

MS-ESS2-3 Analyze and interpret data on the distribution of fossils and rocks, continental shapes, and seafloor
structures to provide evidence of the past plate motions.
http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=225

Science and Engineering Practices

Analyzing and Interpreting Data

Analyzing data in 6-8 builds on K-5 experiences
and progresses to extending quantitative analysis
to investigations, distinguishing between
correlation and causation, and basic statistical
techniques of data and error analysis.

A\

ESS1.C: The History of Planet Earth
Tectonic processes continually generate new
ocean sea floor at ridges and destroy old sea
floor at trenches.

Crosscutting Concepts

Patterns

Patterns in rates of change and other numerical
relationships can provide information about
natural systems.

HS-ESS2-1 Develop a model to illustrate how Earth’s internal and surface processes operate at different spatial and
temporal scales to form continental and ocean-floor features.
http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=183

Science and Engineering Practices

Developing and Using Models

Modeling in 9-12 builds on K-8 experiences and
progresses to using, synthesizing, and developing
models to predict and show relationships among
variables between systems and their components
in the natural and designed world(s)

A\

ESS2.A: Earth Materials and Systems

Earth’s systems, being dynamic and interacting,
cause feedback effects that can increase or
decrease the original changes.

ESS2.B: Plate Tectonics and Large-Scale
System Interactions

Plate tectonics is the unifying theory that
explains the past and current movements of the
rocks at Earth’s surface and provides a
framework for understanding its geologic
history.

Plate movements are responsible for most
continental and ocean-floor features and for the
distribution of most rocks and minerals within
Earth’s crust.

Crosscutting Concepts

Stability and Change

Change and rates of change can be quantified
and modeled over very short or very long
periods of time. Some system changes are
irreversible.

14

APPENDIX


http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=225
http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=183

Waves and Their Applications in Technologies for Information Transfer

HS-PS4-1 Use mathematical representations to support a claim regarding relationships among the frequency,
wavelength, and speed of waves traveling in various media. [Clarification Statement: Examples of data could
include electromagnetic radiation traveling in a vacuum and glass, sound waves traveling through air and water,
and seismic waves traveling through the Earth.] http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=116

Science and Engineering Practices

Using Mathematics and Computational
Thinking

Mathematical and computational thinking at the
6-8 level builds on K-5 experiences and
progresses to identifying patterns in large data
sets and using mathematical concepts to support
explanations and arguments.

A\

PS4.A: Wave Properties

A simple wave has a repeating pattern with a
specific wavelength, frequency, and amplitude.

Crosscutting Concepts

Patterns

Graphs and charts can be used to identify
patterns in data..

HS-PS4-5 Communicate technical information about how some technological devices use the principles of wave
behavior and wave interactions with matter to transmit and capture information and energy.
http://ngss.nsta.org/DisplayStandard.aspx?view=pe&id=122

Science and Engineering Practices

Obtaining, Evaluating, and Communicating
Information

Obtaining, evaluating, and communicating
information in 9-12 builds on K-8 experiences
and progresses to evaluating the validity and
reliability of the claims, methods, and designs.

A\

PS4.C: Information Technologies and
Instrumentation

Multiple technologies based on the
understanding of waves and their interactions
with matter are part of everyday experiences in
the modern world (e.g., medical imaging,
communications, scanners) and in scientific
research. They are essential tools for producing,
transmitting, and capturing signals and for
storing and interpreting the information
contained in them.

Crosscutting Concepts

Cause and Effect
Systems can be designed to cause a desired
effect.
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RIS

www.iris.edu/earthquake

EXPLORING PATTERNS IN GLOBAL & REGIONAL SEISMICITY

Part 1: Global Seismicity

Step 1: Visit the IRIS Earthquake Browser (http://www.iris.edu/ieb). You will be using this web application to plot
earthquake event data on a map. Upon opening the site, you will be presented with a map of the world with the
1000 most recent earthquakes plotted.

Options >

Step 2: Use the drop down menu to change the number of quakes displayed to 5000. — Hake chenges, press Apply.

s L u " PO . Max quakes:| 5000 3
Then click“Apply” and note the distribution of earthquakes. Werning: Alow more e when

large numbers of quakes are
displayed.

Question(s)

1. In what ways do you think a cracked hard-boiled egg might serve as a
model for the spatial distribution of earthquake data?

2. In what ways do you think the comparison to the c acked hard-boiled
eqgg fails as a model?

3. Describe any other models you might think of besides this one to describe the seismic data.

Sw-1
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Part 2: Global Seismicity

Step 1: Explore! You can zoom in on the map, move it around, select a specific region of interest, and click on
individual events to get more details about that particular earthquake. On the right-hand side of the window, you
will be able to change the number of events displayed as well as the time, magnitude, and depth ranges of events
that are displayed on the map. You can also change the view from geopolitical boundaries to a satellite or terrain
view.

Step 2: Use the IRIS Earthquake Browser to answer the following qustions.

1. How many events happened globally on your birthday? How large was the largest event on that day and where was
it? How deep was the deepest event, and where was that event located?

2. Describe how a global map looks different if you only display 5000 events that are all Magnitude 7.5 or larger?

3. How many events occurred in our state in the past year? How does your findings compare to an analysis of the same
region during the 12 months from April 1 2005 to April 1 2006)?

4. After exploring the map and data:
a) Describe at least three observations you made about earthquakes.

b) Write at least two questions you now have about earthquakes as a result of exploring this data.

. SW-2
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Part 3: Exploring Specific Regions...

Use the URLs in Table 1 to visit Sites 1- 4. Respond to the following prompts for each site in the table.

Fill in Table 1

» Name the location
« Describe the frequency and magnitude range of earthquakes for each site.
« Describe the depth distribution of the earthquakes for each site.

You should view both the map colors as well as clicking on“3D VIEWER” in the right menu.

- Describe the spatial distribution of the earthquakes for each site.
« Turn on satellite view for each region. Describe physical features that appear to correspond to earthquakes.

- Identify other region(s) of the world that have similar features to those you noted for each site.

TABLE 1

Site 1
http://go0.gl/8dRNBo

Site 2
http://goo.gl/Cbh3UV

Site 3
http://goo.gl/TDOu2A

Site 4

http://goo.gl/rqEIGb

Location

Frequency/
Magnitude

Depth
distribution
(sketch?)

Spatial
distribution

Physical
features

Similar
region(s)
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Part 4: Comparing researched region sites to accepted models

Earth’s outer surface is broken into many large rigid pieces called tectonic plates. Over long periods of
time, these plates move very small amounts annually. As the plates move about they are constantly
interacting with one another in a variety of ways. Depending on the type of interaction and the
density of the plate material, these interactions can result in the formation of large-scale features,
such as mountains and deep ocean trenches. They can cause more abrupt and catastrophic effects,
such as earthquakes, tsunamis and volcanism. Below are three models for the ways in which
scientists believe these plates interact with one another.

Model 1: As plates move sometimes they are squeezed
into one another. As a result, high mountains are
formed. This model is called a convergent boundary
and generally is known for a high rate of seismicity,
and can generate in large quakes.

Continental-continental convergence

Name a Site location from Table 1:

Model 2: Sometimes the two plates that are squeezed
together are made of different material. When this
occurs the denser plate is forced below the less
dense plate in a process known as subduction. This
is generally known for a high rate of seismicity, can
generate very large quakes, and can result in the
formation of very deep ocean trenches.

Subduction
|eZmee| . g \.

Name a Site location from Table 1:

Model 3: In some places plates are push/pulled apart
to allow new material to come to the surface and
form new plate material. These regions, known as
divergent boundaries have relatively low rates of
seismicity that occur in relatively narrow bands, and
are generally shallow and small events.

Name a Site location from Table 1:

SW-4
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Task A: Now that you have reviewed the models and given Site examples for each, let's go back to Site 1.

You are going to develop an argument for the model that best describes the data from Site 1.
First let's develop a what, where, why, or how question about what you learned in Part 3. As an example we will
look at Site 2. Sample questions that we could ask (because we have evidence for them) include:

+ How are the earthquakes different from those in a subduction zone? They are all shallow and rarely very big.
Look at the 3-D view by selecting "View" > "Look North" and "View" > "Rotate Side to Side."
When you compared the 3-D views of Site 1 and Site 2 you could see how different they were.

« Where do the earthquakes occur in Site 2? Close to the spreading ridge itself where the rock is brittle.

Now think of a question about Site 1 that you can write a claim about:
Question

Claim A statement that answers the original question or problem.
What conclusion can you make about your original question or problem?

Evidence (List scientific data that are relevant to the problem and sufficient to support the claim.)
What data or observations do you have to support your claim?

SW-5
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Task B: Review each model and compare each to the data you collected in Table 1.

Now, develop an argument for the model that best describes the data from Site 4, plus one other site of your
choosing.

As you compare and contrast, include the following elements in your argument:

Question Develop a question about what you learned in Part 3 that can be answered by the elements below.

Claim Write a conclusion that answers the original question about a phenomenon.

Evidence (List scientific data that are relevant to the problem and help determine and support the claim.
The data needs to be appropriate and sufficient to support the claim.)

Reasoning (A justification that links the claim and evidence. It shows why the data count as evidence by
using appropriate and sufficient scientific principles.)

SW-6
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Part 5: Revisiting the Egg Model

Revisit your responses to questions 1 and 2 in Part 1. Now that you have explored the earthquake event data and
accepted models of plate tectonics more deeply, you may wish to revise your responses.

1. In what ways do you think a cracked hard-boiled egg might serve as a model for the spatial
distribution of earthquake data and the three models of plate interactions?

2. In what ways do you think the comparison to the cracked hard-boiled egg fails as a model?

SW-7
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INSTRUCTOR ANSWER KEY

s
IRIS

www.iris.edu/earthquake Date

EXPLORING PATTERNS IN GLOBAL & REGIONAL SEISMICITY

Part 1: Global Seismicity
Step 1: Visit the IRIS Earthquake Browser (http://www.iris.edu/ieb). You will be using this web application to plot
earthquake event data on a map. Upon opening the site, you will be presented with a map of the world with the
1000 most recent earthquakes plotted.

Options >
Step 2: Use the drop down menu to change the number of quakes displayed to 5000. Make changes, press Apply:
Then click “Apply” and note the distribution of earthquakes. T |Maxquakes:| s000 %

Warning: Allow more time when
large numbers of quakes are
displayed.

Question(s)

1. In what ways do you think a cracked hard-boiled egg might serve as a
model for the spatial distribution of earthquake data?

Like the rocky outer layer of Earth (the lithosphere) the egg shell is the
thinnest layer Consider the scale of shell relative to the whole egg.

The cracks (representing earthquake locales) are places where the
pieces of the egg shell are able to move slightly and interact with
one another.

The brittle texture of the egg shell is relative to the brittle rocky outer

layer of Earth (lithosphere). The semi solid egg white is relative to
Earth'’s solid but not brittle mantle layer below.

2. In what ways do you think the comparison to the cracked hard-boiled egg fails as a model?

Scale, composition, ; lack of heat source to generate convection and plate motion.

3. Describe any other models you might think of besides this one to describe the seismic data.

Answers will vary
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Part 2: Global Seismicity

Step 1: Explore! You can zoom in on the map, move it around, select a specific region of interest, and click on
individual events to get more details about that particular earthquake. On the right-hand side of the window, you
will be able to change the number of events displayed as well as the time, magnitude, and depth ranges of events
that are displayed on the map. You can also change the view from geopolitical boundaries to a satellite or terrain
view.

Step 2: Use the IRIS Earthquake Browser to answer the following qustions.

1. How many events happened globally on your birthday? How large was the largest event on that day and where was
it? How deep was the deepest event, and where was that event located?

Answers will vary

2. Describe how a global map looks different if you only display 5000 events that are all Magnitude 7.5 or larger?

They cluster near the edges of continents where subduction occurs convergent margins,
vs. spreading across continents

3. How many events occurred in our state in the past year? How does your findings compare to an analysis of the same
region during the 12 months from April 1 2005 to April 1 2006)?

Answers will vary

4. After exploring the map and data:
a) Describe at least three observations you made about earthquakes.

Answers will vary

b) Write at least two questions you now have about earthquakes as a result of exploring this data.

Answers will vary
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Part 3: Exploring Seismicity in Specific Regions
Use the URLs in Table 1 to visit Sites 1- 4. Respond to the following prompts for each site in the table.

Fill in Table 1 below
« Name the location
« Describe the frequency and magnitude range of earthquakes for each site.

« Describe the depth distribution of the earthquakes for each site. You should view both the map colors as well as
clicking on“3D VIEWER” in the right menu.

« Describe the spatial distribution of the earthquakes for each site.

- Turn on satellite view for each region. Describe physical features that appear to correspond to
earthquakes.

- Identify other region(s) of the world that have similar features to those you noted for each site.

Site 1 Site 2 Site 3 Site 4
TABLE 1 http://goo. http://goo.gl/ http://goo.gl/ http://goo.gl/
gl/8dRNBo Cbh3Uuv TDOu2A rqEIGb
Location
Japan Mid Atlantic Ridge Himalayas East African Rift
F Lots! Few! Medium
requency/
Maanitud >11,000 of all 500 since 2011 Almost 3,000 since Only 365 since 2011
agnitude magnitudes, but Butonly1>M7 2011, but only none >M 5
only 13>M7 7>M7
Varies but many Varies but many deep
Depth deep most are shallow All <33 km
distribution Very few deeper
(sketch?) From shallow to than150 Km
over 500 km deep
Broad smear Narrow and linear Sharp line along Concentration
the plate boundary along the plate
Spatial concentrated along Concentrated along Bflt k‘)roadly. boi?dagx th:]t
distribution | subductio n-zone the mid- ocean distributed in the scatteredin the
boundaries ridge compressed region south.
Mountains and Zooming in Most earthquakes
Physical the trench are shows the occur in the
features defined by structure of mountainous
earthquakes the mountain region
range & faults
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Part 4: Comparing to accepted models

Earth’s outer surface is broken into many large rigid pieces called tectonic plates. Over long periods of
time, these plates move very small amounts annually. As the plates move about they are constantly
interacting with one another in a variety of ways. Depending on the type of interaction and the
density of the plate material, these interactions can result in the formation of large-scale features,
such as mountains and deep ocean trenches. They can cause more abrupt and catastrophic effects,
such as earthquakes, tsunamis and volcanism. Below are three models for the ways in which
scientists believe these plates interact with one another.

Model 1: As plates move sometimes they are squeezed
into one another. As a result, high mountains are
formed. This model is called a convergent boundary
and generally is known for a high rate of seismicity,
and can generate in large quakes.

Continental-continental convergence
Name a Site location from Table 1: Site 3, Himalayas

F%”""H I
Model 2: Sometimes the two plates that are squeezed e
together are made of different material. When this
occurs the denser plate is forced below the less
dense plate in a process known as subduction. This
is generally known for a high rate of seismicity, can
generate very large quakes, and can result in the
formation of very deep ocean trenches.

Name a Site location from Table 1: Site 1, Japan

Model 3: In some places plates are push/pulled apart
to allow new material to come to the surface and
form new plate material. These regions, known as
divergent boundaries have relatively low rates of
seismicity that occur in relatively narrow bands, and
are generally shallow and small events.

Name a Site location from Table 1: Site 2, Mid-Atlantic Ridge

26
INSTRUCTOR ANSWER SHEETS



INSTRUCTOR ANSWER KEY

Task A: Now that you have reviewed the models and given Site examples for each, let's go back to Site 1.

You are going to develop an argument for the model that best describes the data from Site 1

First let's develop a what, where, why, or how question about what you learned in Part 3. As an example we will
look at Site 2. Sample questions that we could ask, because we have evidence for them, include:

« How are the earthquake different from those in a subduction zone? They are all shallow and rarely very big
Look at the 3-D view by selecting "View" > "Look North" and "View" > "Rotate Side to Side."
When you compared the 3-D views of Site 1 and Site 2 you could different they are.

« Where do the earthquakes occur in Site 2? Close to the spreading ridge itself where the rock is brittle.

Now develop a question about Site 1 that you can write a claim about
Question

Answers will vary

Claim A statement that answers the original focus question or problem.
What conclusion can you make about your original question or problem?

Answers will vary

Evidence (List scientific data that are relevant to the problem and sufficient to support the claim.)
What data or observations do you have to support your claim?

Answers will vary
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Task B: Review each model and compare each to the data you collected in Table 1.

Now, develop an argument for the model that best describes the data from Site 4, plus one other site of your
choosing.

As you compare and contrast, include the following elements in your argument:
Question Develop a question about what you learned in Part 3 that can be answered by the elements below.

Answers will vary but site 4 is most similar to model 3

Claim Write a conclusion that answers the original question about a phenomenon.

Answers will vary

Evidence (List scientific data that are relevant to the problem and help determine and support the claim.
The data needs to be appropriate and sufficient to support the claim.)

Answers will vary

Reasoning (A justification that links the claim and evidence. It shows why the data count as evidence by
using appropriate and sufficient scientific principles.

Answers will vary
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Part 5: Revisiting the Egg Model

Revisit your responses to questions 1 and 2 in Part 1. Now that you have explored the earthquake event data and
accepted models of plate tectonics more deeply, you may wish to revise your responses.

1. In what ways do you think a cracked hard-boiled egg might serve as a model for the spatial
distribution of earthquake data and the three models of plate interactions?

- Both have a thin, brittle shell.

« cracked shell of a hardboiled egg is broken into pieces that can be analogous to plates.
« The plates move relative to each other.

« The plates have edges, where the earthquakes could occur

2. In what ways do you think the comparison to the cracked hard-boiled egg fails as a model?

« Eggshell pieces, for the most part, have the same density whereas the plates on Earth vary in
density.

« The eggshells do not move while the plates do.
« There is no internal heat to drive the convection, thus plate motion.
- Plate motion makes earthquakes

« The egg has one inner section (yolk) whereas the Earth’s core comprises a solid inner core and a
liquid outer core.

- Motion is continuous, not a static earth.
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